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Safety Instructions
Read and Keep these Instructions

Warning

Important Safety Instructions

1 Read these instructions.

2 Keep these instructions.

3 Heed all warnings.

4 Follow all instructions.

5 Do not use this equipment near water.

6 Clean only with dry cloth.

7 Do not block any ventilation openings. Install in accordance with the manufacturer’s instructions.

8 Do not install near any heat sources such as radiators, heat registers, stoves, or other equipment (includ-
ing amplifiers) that produce heat.

9 Protect power cords from being walked on or pinched particularly at plugs, convenience receptacles, 
and the point where they exit from the equipment.

10 Only use attachments/accessories specified by the manufacturer.

11 For products that are not rack-mountable: Use only with a cart, stand, tripod, bracket, or table specified 
by the manufacturer, or sold with the equipment. When a cart is used, use caution when moving the 
cart/equipment combination to avoid injury from tip-over.
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12 Unplug this equipment during lightning storms or when unused for long periods of time.

13 Refer all servicing to qualified service personnel. Servicing is required when the equipment has been 
damaged in any way, such as power-supply cord or plug is damaged, liquid has been spilled or objects 
have fallen into the equipment, the equipment has been exposed to rain or moisture, does not operate 
normally, or has been dropped.

14 For products that are a Mains powered device:

The equipment shall not be exposed to dripping or splashing and no objects filled with liquids (such as 
vases) shall be placed on the equipment.

Warning! To reduce the risk of fire or electric shock, do not expose this equipment to rain or moisture.

Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades 
with one wider than the other. A grounding type plug has two blades and a third grounding prong. The wide 
blade or the third prong are provided for your safety. If the provided plug does not fit into your outlet, con-
sult an electrician for replacement of the obsolete outlet.

15 For products containing a lithium battery:

CAUTION! Danger of explosion if battery is incorrectly replaced. Replace only with the same or equiva-
lent type.

16 For products with a power switch: It should remain accessible after installation.

17 The equipment shall be used at a maximum ambient temperature of 40° C.

18 This unit is provided with a power supply cord set suitable for 120V AC input only (for U.S.A. and Can-
ada). For other than U.S.A. and Canada, a qualified person must provide for use with this unit, an ap-
propriate, approved power supply cord set which is in compliance with the end use country 
requirements and has a minimum cross-sectional area of 1.0mm2.

19 For products with more than one power cord:

CAUTION: This unit has more than one power supply cord. Disconnect two power supply cords before 
servicing to avoid electrical shock.

ATTENTION: Cet appareil comporte plus d’un cordon d’alimentation. Afin de prévenir les chocs élec-
triques, débrancher les deux cordons d’alimentation avant de faire le dépannage.

20 For products with an operator-accessible fuse:

CAUTION: For continued protection against risk of fire, replace only with same type and rating of fuse.

ATTENTION: Pour ne pas compromettre la protection contre les risques d’incendie, remplacer par un fus-
ible de même type et de même caractéristiques nominales.
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Rack-Mount Safety Instructions

1 Elevated Operating Ambient—If installed in a closed or multi-unit rack assembly, the operating ambient 
temperature of the rack environment might be greater than room ambient. Therefore, consider installing 
the equipment in an environment compatible with the maximum ambient temperature (Tma) specified 
by the manufacturer.

2 Reduced Air Flow—Installation of the equipment in a rack should be such that the amount of air flow 
required for safe operation of the equipment is not compromised. Make allowances for cooling air to be 
available to the front panel surface and no restrictions at the rear.

3 Mechanical Loading—Mounting of the equipment in the rack should be such that a hazardous condition 
is not achieved due to uneven mechanical loading.

4 Circuit Overloading—Consideration should be given to the connection of the equipment to the supply 
circuit and the effect that overloading of the circuits might have on over-current protection and supply 
wiring. Appropriate consideration of equipment nameplate ratings should be used when addressing this 
concern.

5 Reliable Earthing—Reliable Earthing of rack-mounted equipment should be maintained. Particular at-
tention should be given to supply connections other than direct connections to the branch circuit (for ex-
ample, use of power strips).

LED Safety Notices

Avid hardware might contain LED or Laser devices for communication use. These devices are compliant 
with the requirements for Class 1 LED and Laser Products and are safe in the intended use. In normal op-
eration the output of these laser devices does not exceed the exposure limit of the eye and cannot cause 
harm.

Environmental Compliance

Proposition 65 Warning

This product contains chemicals, including lead, known to the State of California to cause cancer and birth 
defects or other reproductive harm. Wash hands after handling.

Perchlorate Notice

This product may contain a lithium coin battery. The State of California requires the following disclosure 
statement: “Perchlorate Material—special handling may apply, see www.dtsc.ca.gov/hazardous waste/
perchlorate.”

Recycling Notice
 Read and Keep these Instructions v

www.dtsc.ca.gov/hazardous waste/perchlorate
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EMC (Electromagnetic Compliance)
Avid declares that this product complies with the following standards:

• FCC Part 15 Class A

• EN 55032:2012, Class A

• EN 61000-3-2:2014, AC Mains Harmonic Current

• EN 61000-3-3:2013, AC Mains Voltage Variations and Flicker

• EN 55103-1:2009, Emissions Environment E4

• EN 55103-2:2009, Immunity Environment E1–E4

FCC Compliance for United States

Safety Compliance
This equipment has been tested to comply with EN 60950-1:2006 + A11:2009 + A1:2010 + A12:2011 
+A2:2013

Power Safety Input Rating

Pro Tools | MTRX Studio: 100-240 VAC, 50/60 Hz, 45 VA Max.

Note: This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference when the equipment is operated in a commercial environ-
ment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the instruction manual, may cause harmful interference to radio 
communications. Operation of this equipment in a residential area is likely to cause harmful in-
terference in which case the user will be required to correct the interference at his own expense.

Cables: Connections to Avid hardware must be made with shielded cables with metallic 
RFI/EMI connector hoods in order to maintain compliance with FCC Rules and Regulations.

Any modifications to the unit, unless expressly approved by Avid, could void the user's authority 
to operate the equipment.
Pro Tools | MTRX Studio Installation Guide



CE Compliance

(EMC, Safety, and RoHS)

Avid is authorized to apply the CE (Conformite Europenne) mark on this compliant equipment thereby de-
claring conformity to EMC Directive 2014/30/EU, Low Voltage Directive 2014/35/EU and RoHS Recast 
Directive 2011/65/EU.
 Read and Keep these Instructions vii
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Chapter 1: Introduction

Pro Tools | MTRX Studio

Welcome to Pro Tools® | MTRX Studio. MTRX Studio is an extremely versatile multi-channel audio in-
terface for Pro Tools | HDX and Pro Tools | HD Native systems. MTRX Studio supports 16- and 24-bit au-
dio with sample rates of 44.1, 48, 88.2, 96, 176.4, and 192 kHz. MTRX Studio provides two DigiLink™ 
Mini ports for up to 64 input and output channels with Pro Tools. MTRX Studio provides 16 analog line 
inputs, 16 analog line outputs, two analog monitor outputs, two headphone outputs, and two analog inputs 
for microphones or instruments. It also provides a 64 I/O channels Dante® IP Audio interface and 16 chan-
nels of ADAT™ I/O, Word Clock and Loop sync synchronization, and an input for a foot switch (for var-
ious DADman functions, such as talk back remote control). Additionally, MTRX Studio provides built-in 
SPQ processing for room tuning, bass management, and equalizing of cue and monitor signals.

MTRX Studio can be used a traditional recording interface, with mic and line analog I/0, phantom power, 
and two headphone jacks on the front panel. MTRX Studio can also be used as a monitor controller output 
device for immersive audio post production applications with up to 9.1.6 channel layouts (though 7.1.4 is 
most common). Pro Mon monitor control functionality is available for EUCON™-enabled Avid devices 
with MTRX Studio using DADman software.

MTRX Studio Features
MTRX Studio provides up to 64 discrete channels of audio for Pro Tools with two DigiLink Mini ports 
(Primary and Primary/Expansion).

Analog I/O
• 2 Instrument/Microphone inputs (with preamps)

• 16 analog line inputs (DB25)

• 16 analog line outputs (DB25)

• 2 monitor outputs (balanced 1/4-inch)

• 2 stereo headphone outputs

1 2

Pro Tools ®  | MTRX Studio

1 2INST
LINK
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Digital I/O
• 64x64 Dante I/O

• 16x16 ADAT I/O

Synchronization
• Sample rates of 44.1–192 kHz 

• Synchronization by Internal, Word Clock, Loop Sync, ADAT, or Dante IP

Control, Routing, and Processing
• Operation using DADman software—some settings can be controlled on the front panel

• All settings controlled over Ethernet

• 512x512 cross-point matrix

• 256x32 summing (Pro | Mon) with monitor profiles

• SPQ processing with 256 filters for 16 channels of speaker EQ

System Requirements and Compatibility Information
Avid can only assure compatibility and provide support for hardware and software it has tested and ap-
proved.

For complete system requirements and a list of qualified computers, operating systems, hard drives, and 
third-party devices, visit www.avid.com/compatibility.
Pro Tools | MTRX Studio Installation Guide
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Conventions Used in Pro Tools Documentation
Pro Tools documentation uses the following conventions to indicate menu choices, keyboard commands, 
and mouse commands:
:

The names of Commands, Options, and Settings that appear on-screen are in a different font.

The names of physical switches on MTRX Studio are in displayed in bold text. 

The following symbols are used to highlight important information:

Convention Action

File > Save Choose Save from the File menu

Control+N Hold down the Control key and press the N key

Control-click Hold down the Control key and click the mouse button

Right-click Click with the right mouse button

User Tips are helpful hints for getting the most from your Pro Tools system.

Important Notices include information that could affect your Pro Tools session data or the perfor-
mance of your Pro Tools system.

Shortcuts show you useful keyboard or mouse shortcuts.

Cross References point to related sections in this guide and other Avid documentation.
Chapter 1: Introduction 3
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Resources
The Avid website (www.avid.com) is your best online source for information to help you get the most out 
of your Avid system. 

Account Activation and Product Registration
Activate your product to access downloads in your Avid account (or quickly create an account if you do not 
have one). Register your purchase online, download software, updates, documentation, and other re-
sources.

www.avid.com/register

www.avid.com/account

Support and Downloads
Contact Avid Customer Success (technical support), download software updates and the latest online man-
uals, browse the Compatibility documents for system requirements, search the online Knowledge Base or 
join the worldwide Avid user community on the User Conference.

www.avid.com/support

Training and Education
Study on your own using courses available online, find out how you can learn in a classroom setting at an 
Avid-certified training center, or view video tutorials and webinars.

www.avid.com/education

Video Tutorials
The Get Started Fast with Pro Tools series of online videos provide tutorials to help if you are new to 
Pro Tools. They also provide videos for the experienced user that introduce new features found in the latest 
versions of Pro Tools.

www.avidblogs.com/get-started-fast-with-pro-tools/

Products and Developers
Learn about Avid products, download demo software, or learn about our Development Partners and their 
plug-ins, applications, and hardware.

www.avid.com/products
Pro Tools | MTRX Studio Installation Guide
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Chapter 2: Installation

Installing Pro Tools | MTRX Studio involves the following:

1 Unpacking MTRX Studio

2 Rack mounting MTRX Studio (optional)

3 Connecting cables

4 Registering your MTRX Studio

5 Downloading and installing software

6 Authorizing Pro Tools DigiLink I/O License with iLok License Manager

7 Configuring network settings

What’s in the Box?
Before you get started installing Pro Tools | MTRX Studio, unpack the box, which contains the following:

• MTRX Studio

• 1 Activation card

• 1 IEC power cable

• 2 BNC cables (for connecting Loop Sync or Word Clock)

• This printed installation guide

Keep the activation card on hand to register your MTRX Studio and access software downloads and firm-
ware updates. Set the power cable and BNC cables aside until you are ready to start connecting cables. Re-
move the MTRX Studio from the box and packaging, and place it on a hard and dry surface.

Rack Mounting MTRX Studio
If you install MTRX Studio into a 19-inch rack, be sure to leave plenty of room for ventilation. MTRX Stu-
dio, as with all Avid audio interfaces, needs room at the sides, as well as above and below, to maintain 
proper air flow for cooling. Do not block the sides of the unit or disconnect the internal fan. If the units are 
rack-mounted in a case, remove the case lids or doors before operating the system. Failure to do so can re-
sult in the units overheating very quickly, which can permanently damage sensitive components.
Chapter 2: Installation 5
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Connecting Cables
Once you have installed MTRX Studio in a rack (optional), you are ready to start connecting cables.

Connect Power
Connect the included IEC cable to MTRX Studio. Then connect the cable to a grounded AC power outlet. 
It is recommended that you connect to a grounded power switch or power conditioner. 

Connect Ethernet
Connect the MTRX Studio directly to your computer or to your computer’s network using a GigaBit 
Ethernet cable (not included) (see “Network Configuration” on page 8).

Connect DigiLink
Connect one or two DigiLink Mini cables (not included) to the DigiLink Mini ports on MTRX Studio. 
Then connect the other end of these cables to an HDX card, or an HD Native card or HD Native Thunder-
bolt box. See Chapter 3, “Connecting Pro Tools | MTRX Studio to an HDX or HD Native System.”

Connect Clock Sync
If you are installing Pro Tools | MTRX Studio in a system with multiple audio interfaces (such as HD I/O) 
and/or a synchronization peripheral (such as SYNC HD), make the appropriate Loop Sync or Word Clock 
cable connections using the included BNC cables.

Connect Audio
Make sure that your sound system is powered off. Make the appropriate analog and digital audio cable con-
nections for your system.

Connect a Footswitch
You can connect a footswitch (optional) to the back of MTRX Studio (1/4-inch jack) to control monitor 
profiles or talkback.

In order to meet EMC requirements and in order to obtain the highest performance of MTRX Studio, use 
high-quality, properly shielded cables for all external connections when installing MTRX Studio. For the 
power connection, a normal unshielded power cable with a proper protective earth conductor can be used.

To orient yourself with MTRX Studio back panel connections, see Chapter 5, “Pro Tools | MTRX Studio 
Front and Back Panels.”
Pro Tools | MTRX Studio Installation Guide



Register Pro Tools | MTRX Studio and Activate your Avid 
Master Account
Your Pro Tools | MTRX Studio includes an Activation card with a code that lets you register the unit, and 
access software, firmware, and documentation downloads.

To register your MTRX Studio and access MTRX Studio-related downloads through your Avid Master 
Account:

1 Locate the Activation card with the code that came with your MTRX Studio.

2 Visit https://www.avid.com/redemption.

3 Log in to your Avid Master Account. If you do not already have an Avid Master Account, create a new 
one and log in.

4 Under My Products, click the Avid Software Activation and Download link.

5 Enter the code on your Activation Card and click Activate Product.

All documentation, software, and firmware relevant to your MTRX Studio will now be available for down-
load under My Products in your Avid Master Account.

Download Software
Once you have registered MTRX Studio, you can download software and firmware updates from your 
Avid Master Account. For DADman installation and configuration instructions, see Chapter 4, “Installing 
and Configuring DADman Software.”

To download MTRX Studio software and firmware:

1 Log in to your Avid Master Account (if you are not already).

2 Under My Products, click the My Products and Subscriptions link.

3 Under the My Products tab, click Pro Tools | MTRX Studio.

4 To the right of Product Details and Download Links, click Show.

5 Click the links for any Read Me documentation about firmware and/or software updates. Review this in-
formation carefully to ensure the successful installation of DADman software, firmware updates, and 
proper function of MTRX Studio.

6 Click the link to download the installer for the latest version of DADman software for your operating 
system (macOS or Windows). DADman software is required to use MTRX Studio with Pro Tools.

For information on installing and configuring DADman, see Chapter 4, “Installing and Configuring 
DADman Software.”
Chapter 2: Installation 7
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Redeem Pro Tools DigiLink I/O License
In order to use MTRX Studio with Pro Tools, you must first authorize your iLok with the Pro Tools 
DigiLink I/O license (which is added to your Avid Master Account when you register MTRX Studio). 
Once you have registered your MTRX Studio, use iLok License Manager to authorize your iLok with the 
Pro Tools DigiLink I/O license.

Network Configuration
MTRX Studio is equipped with two GigaBit Ethernet connectors and an internal Ethernet switch, a con-
troller port and a port for IP Audio Dante I/O. The network connectors can operate as two “parallel” con-
nectors for the internal switch or as dual connectors for redundant IP audio operation. When operating in 
parallel, controlling the unit is done using Net port 1. MTRX Studio has one to three different IP addresses. 
One for the unit control using DADman software and one or two for the IP audio in single or redundant 
mode respectively. The network configuration is managed separately for the controlling interface and for 
the IP audio interface, and can have different configurations. The controlling interface is used for con-
trolling MTRX Studio from DADman, and the IP audio interface is used for interfacing IP audio in a net-
work.

The factory default setting of the IP address of the controller port of the MTRX Studio is 10.0.7.20. The IP 
address can be changed manually using DADman or it can be set to be automatically assigned by a DHCP 
server/router in the network. If needed, MTRX Studio can be set in recovery mode with the fixed factory 
defined IP address (10.0.7.20) and IP discovery using DHCP. This is described in the Reconfiguration sec-
tion of this guide. For a more detailed description of the network functionality, configuration, and behav-
ior, please refer to the separate MTRX Studio Operation Guide.pdf (available for download from your Avid 
Master Account).

MTRX Studio is supported by Pro Tools | Ultimate 2019.12 or later.
Pro Tools | MTRX Studio Installation Guide



Starting Up or Shutting Down Your System
To ensure that the components of your Pro Tools system communicate properly with each other, you need 
to start them in a particular order.

Start up your Pro Tools system in this order:

1 Make sure all your equipment (including your computer) is off.

2 Lower the volume of all output devices in your system. 

3 For systems with an expansion chassis, turn on the chassis.

4 Turn on any external hard drives. Wait approximately ten seconds for them to spin up to speed.

5 Turn on your network router (if it is not already on).

6 Turn on any control surfaces (such as S6).

7 Turn on any MIDI interfaces, MIDI devices, or synchronization peripherals.

8 With the volume of all output devices lowered, turn on your audio interfaces (such as MTRX Studio). 
Wait at least fifteen seconds for your system hardware to initialize.

9 Turn on your computer. 

10 Launch Pro Tools or any third-party audio or MIDI applications.

Shut down your Pro Tools system in this order:

1 Quit Pro Tools and any other running applications. 

2 Turn off or lower the volume of all output devices in your system.

3 Turn off your computer.

4 Turn off your Pro Tools audio interfaces (such as MTRX Studio).

5 For systems with an expansion chassis, turn off the chassis.

6 Turn off any MIDI interfaces, MIDI devices, or synchronization peripherals.

7 Turn off any control surfaces (such as S6).

8 Turn off any external hard drives.

To quit Pro Tools, choose Pro Tools > Quit (Mac) or File > Exit (Windows).
Chapter 2: Installation 9
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Chapter 3: Connecting Pro Tools | MTRX 
Studio to an HDX or HD Native System

Pro Tools | MTRX Studio can be configured for a wide variety of audio production workflows with 
Pro Tools | HDX or HD Native hardware. 

HDX With HDX hardware, MTRX Studio is connected to an HDX card using one or two DigiLink Mini ca-
bles (not included). You can connect additional HD audio interfaces to your system using the second Dig-
iLink Mini port on the back of MTRX Studio, the second DigiLink Mini Port on the HDX card, or by using 
additional HDX cards. See “Connecting Pro Tools | MTRX Studio to Pro Tools | HDX” on page 12. 

HD Native With HD Native hardware, MTRX Studio is connected to the HD Native card using one or two 
DigiLink Mini cables (not included). You can connect additional HD audio interfaces to your system using 
the second DigiLink Mini port on the back of MTRX Studio or the second DigiLink Mini Port on the HD 
Native card. See “Connecting Pro Tools | MTRX Studio to Pro Tools | HD Native” on page 14.

Studio Connections

Pro Tools | MTRX Studio can be integrated with your other equipment in several ways, depending on your 
needs. For examples, see “Example Studio Connections” on page 22. 

For more information about installing HDX cards, see the Pro Tools | HDX Card Installation Guide.

For more information about installing the HD Native card, see the Pro Tools | HD Native Installation 
Guide.

For more information about installing HD Native Thunderbolt, see the Pro Tools | HD Native Thunder-
bolt Installation Guide.
Chapter 3: Connecting Pro Tools | MTRX Studio to an HDX or HD Native System 11
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Connecting Pro Tools | MTRX Studio to Pro Tools | HDX
You can use up to 64 channels of analog and digital I/O with MTRX Studio connected to an HDX card us-
ing two DigiLink Mini cables (not included).

To connect MTRX Studio to an HDX card:

1 Connect the first MTRX Studio DigiLink Mini Port to DigiLink Mini Port 1 on the HDX card using a 
DigiLink Mini cable (not included).

2 Connect the second MTRX Studio DigiLink Mini Port to DigiLink Mini Port 2 on the HDX card using 
a second DigiLink Mini cable (not included).

+

Figure 1.  MTRX Studio connected to both DigiLink Mini ports on an HDX card
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MTRX Studio with a MADI I/O in an HDX 2 System
The following shows MTRX Studio and MADI I/O with Loop Sync connections and DigiLink Mini 
connections with two HDX cards.

Figure 2.  HDX 2 system: MTRX Studio connected to both DigiLink Mini ports on HDX card 1, MADI I/O connected to both 
DigiLink Mini port s on HDX card 2, Loop Sync connections between MTRX Studio and MADI I/O
Chapter 3: Connecting Pro Tools | MTRX Studio to an HDX or HD Native System 13
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Connecting Pro Tools | MTRX Studio to Pro Tools | HD Native
You can use up to 64 channels of analog and digital I/O with MTRX Studio connected to an HD Native 
card or HD Native Thunderbolt using two DigiLink Mini cables (not included).

To connect MTRX Studio to an HD Native card or HD Native Thunderbolt:

1 Connect the first MTRX Studio DigiLink Mini Port to DigiLink Mini Port 1 on the HD Native card or 
HD Native Thunderbolt using a DigiLink Mini cable (not included).

2 Connect the second MTRX Studio DigiLink Mini Port to DigiLink Mini Port 2 on the HD Native card 
or HD Native Thunderbolt using a second DigiLink Mini cable (not included).

Synchronization
If you are using two or more audio interfaces or a synchronization peripheral, each device must be con-
nected to a clock source to maintain proper synchronization among the devices. MTRX Studio provides In-
ternal clock, and can also clock to Word Clock, Loop Sync, ADAT, or Dante IP. Use Internal if MTRX is 
your master clock. Use Loop Sync with Pro Tools HD audio interfaces if you want to use another periph-
eral as the master clock (such as HD I/O or HD MADI, and SYNC HD). 

Figure 3.  MTRX Studio connected to both DigiLink Mini ports on an HD Native card

To orient yourself with MTRX back panel connections, see Chapter 5, “Pro Tools | MTRX Studio Front 
and Back Panels.”
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Example System Configurations
The following diagram shows an example music studio configuration using an Avid S1 and Pro Tools 
Dock for controlling DADman and Pro Tools using EuControl, analog output tuned with SPQ speaker pro-
cessing for control room monitoring, Dante digital output for Cue mixes, ADAT input for 16 channels of 
mic preamp input (using outboard AD converters), and DB25 analog I/O for hardware inserts (outboard 
processing).

Example music studio configuration
Chapter 3: Connecting Pro Tools | MTRX Studio to an HDX or HD Native System 15
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The following diagram shows an example Dolby Atmos configuration using the Avid Control app for con-
trolling DADman and Pro Tools using EuControl, DB25 analog output tuned with SPQ speaker processing 
for 7.1.4 monitoring, and Dante digital output for Dolby Atmos rendering.

Example Dolby Atmos configuration
Pro Tools | MTRX Studio Installation Guide



Chapter 4: Installing and Configuring 
DADman Software

Installing DADman Software
MTRX Studio is controlled over a network connection by DADman software on your computer. Your 
computer and MTRX Studio must be connected on the same subnet.

To install DADman Software:

1 If you have not already done so, download the DADman Software installer for your operating system 
(macOS or Windows) from your Avid Master Account. 

2 Once the download is complete, launch the installer and follow the on-screen instructions to complete 
the installation.

3 If desired, create a shortcut for DADman on the Desktop, or in the Dock (Mac) or in the Start menu 
(Windows).

4 Launch DADman.

5 Choose Settings > Device List.
Chapter 4: Installing and Configuring DADman Software 17
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6 Click Refresh to discover the MTRX Studio on the network. If MTRX Studio is properly connected and 
operational, the HW Status reads OK.

7 Right-click the MTRX Studio and choose Network Settings.

Device List dialog

Device List, Right-click menu
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8 Configure the Network Settings accordingly (see “Assigning the IP Address for your Computer and 
Pro Tools | MTRX Studio” on page 19).

Assigning the IP Address for your Computer and 
Pro Tools | MTRX Studio
When DADman is installed you can finalize the network configuration of the MTRX Studio. 

If you have more than one MTRX Studio, connect and configure each MTRX Studio one by one.

You have the option of using fixed IP addresses or IP addresses assigned by DHCP.

Network Settings

When using MTRX Studio units in Pro Tools systems with EUCON peripherals (such as S6), use a ded-
icated Network Interface for EUCON peripherals and connect all other network devices to a separate 
Network Interface (for MTRX Studio/DADman, Dante audio, local network, internet, and so on). Using 
separate Network Interfaces is especially important when streaming audio over Dante.

In order for MTRX Studio to function properly, the router must be correctly configured in DADman soft-
ware.
Chapter 4: Installing and Configuring DADman Software 19
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Fixed IP Address
You must have a preferred range of IP addresses, and a network mask for the computer network and the 
connected MTRX Studio.

To use a fixed IP address:

1 Configure your computer IP address and network mask using the Mac System Preferences or the Win-
dows Control Panel to 10.0.7.25 | 255.255.255.0.

2 Choose Settings > Device List, then right-click the MTRX Studio and choose Network Settings.

3 Configure the MTRX Studio with a unique IP address and preferred network mask, for example 
10.0.7.21 | 255.255.255.0. In this window you can also configure the IP audio network settings.

Automatic IP address
You must have a network with a DHCP server to allocate the IP addresses.

To use an automatic IP address:

1 Configure your computer IP address to DHCP using the Mac System Preferences or the Windows Con-
trol Panel.

2 Choose Settings > Device List, then right-click the MTRX Studio and choose Network Settings.

3 Configure the MTRX Studio to use DCHP.
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DADman Matrix Connections
To route audio through MTRX Studio, you need to create or import DADman settings (.dms files). You can 
download a default stereo DADman settings file from your Avid Master account: Stereo Default.dms.

To open a DADman settings file:

1 Choose File > Open.

2 Navigate to the DADman Settings file (.dms) you want to open and select it.

3 Click Open.

Making Routing Connections
In order to route audio to and from MTRX Studio inputs and outputs and Pro Tools, make the appropriate 
connections in the DADman cross-point matrix. For example, assign AD to DigiLink 1 and DA to 
DigiLink 1 for analog input and output with Pro Tools.

MTRX Studio AD (DB25 analog input 1–16) mapped to DigiLink Mini port 1

For information about making connections in the DADman cross-point matrix, see MTRX Studio 
Operation Guide.pdf
Chapter 4: Installing and Configuring DADman Software 21
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Monitor Profiles
To use the monitoring and cue functionality of MTRX Studio, you need to create or import monitor profiles 
(.dmprof files). You can download a default stereo monitor profile configuration from your Avid Master 
account: Stereo Default.dmprof.

To import a monitor profile:

1 Choose File > Open Profile.

2 Navigate to the profile (.dmprof) you want to open and select it.

3 Click Open.

4 To see how the imported monitor profile is configured, choose Settings > Monitor Profile.

Monitor Profile Configuration window: Default Stereo Profile settings, Control Room Output assignments shown

For information about making creating and editing monitor profiles in DADman, see MTRX Studio 
Operation Guide.pdf
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Chapter 5: Pro Tools | MTRX Studio Front and 
Back Panels

Pro Tools | MTRX Studio Front Panel

1 Instrument inputs 1 and 2 (mono 1/4-inch). These inputs are shared with the Mic inputs on the back 
panel, select INST inputs to use these inputs.

2 Power button.

3 INPUT button — Toggles Mic/Inst inputs 1 and 2 between INST (front panel) or MIC (back panel) when 
PRE is activated. Press the Select button (14) to toggle between channels 1 and 2 (the number for the 
corresponding channel illuminates above the encoder (13). If the channels are linked, the INPUT button 
toggles both channels in tandem.

4 PRE button — When activated, the PRE button lights green and you can change the input settings for 
Mic/Inst inputs 1 and 2. Press the Select button (14) to switch between channel 1 and channel 2. Press 
INPUT (3) to toggle between INST (front panel) or MIC (back panel). Press the A button (11) to link or 
unlink channels 1 and 2. Press B to enable or disable Ø. Press C to switch 48V (phantom power) on or 
off. Use the encoder (13) and the horizontal meter (12) to adjust input levels.

Pro Tools | MTRX Studio front panel

1 2

Pro Tools ®  | MT RX Studio

1 2INST
LINK

1 2

3 4 5

6 7

10

13 16 17

8 9 11 14 1512
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5 Indicators (from top to bottom) — Displays the Mic/Inst input settings per channel when PRE (4) is ac-
tivated.

• EXT — Lights green to indicate sync lock to an external clock source, or flashes red to indicate that 
sync is not locked.

• MIC — Indicates Mic input for the selected channel.

• INST — Indicates Instrument input for the selected channel.

• Link — Indicates that channels 1 and 2 are linked.

• Ø — Indicates phase invert for the selected channel.

• 48V — Indicates phantom power is enabled for the selected channel.

6 16 segmented LED meters indicating signal level of the selected source (analog, ADAT, or Dante) input 
or output. 

7 OUT button — Press to set the 16 segmented LED meters to display output levels for the selected source.

8 Meter button — Press to cycle between sources for the 16 segmented LED meters: analog, ADAT, and 
Dante (1–4). The individual sources for metering are indicated by different colors in the meters and 
channels numbers. The mapping is shown in table 1 below.

9 IN button — Press to set the 16 segmented LED meters to display input levels for the selected source.

10 CR, Monitor/Cue Level meter — Shows the level of the left and right signal of the control room output 
or the monitor/cue output. The readout follows the selection made using the Speaker (15), Headphone 
(16), and Select (14) buttons.

Note that levels for the Mic/Inst input channels (1/4-inch inputs on the front panel and XLR inputs on the 
back panel) are not shown in the 16 segmented LED meters. Likewise, these meters do not show the levels 
for the monitor outputs (1/4-inch jacks on the back panel).

Meter sources

Meter button push Color Viewed Channels Meter Number highlight

Mode 1 Light Blue Analog channels Light Blue

Mode 2 Dark Blue ADAT channels Dark Blue

Mode 3 Orange Dante channels 1–16 Orange, 1 White

Mode 4 Orange Dante channels 17–32 Orange, 2 White

Mode 5 Orange Dante channels 33–48 Orange, 3 White

Mode 6 Orange Dante channels 49–64 Orange, 4 White
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11 A, B, and C buttons — These three buttons illuminate A, B, and C. When PRE (4) is activated, use these 
buttons to change the settings for the two Mic/Inst inputs. When the Pre button is not activated, the A, 
B, and C buttons are used to select configured DADman monitor profiles. The function of these can be 
configured access any available monitor function, such as input source selection, speaker set selection, 
folddown, and so on. These buttons are also layered using the Select button (15) along with the Level 
control encoder (13), and the level and channel indicators (12).

12 Level and Channel indicators — When PRE (4) is activated, the Level meter shows the input gain levels 
for the selected Mic/Line input and the Channel indicators show which channel is selected for editing (1 
or 2, or both). Otherwise, these show the output level for the selected Monitor/Cue source, and which 
source is selected (defined in DADman).

13 Encoder — When PRE (4) is activated, turning the encoder adjusts the input gain level for the selected 
Mic/Line input. Otherwise, turning the encoder adjusts the monitor level for the selected Monitor/Cue 
source. The encoder can also be assigned to various functions in DADman when turned or pushed. For 
example, you can assign the encoder to mute and unmute the selected monitor path when pushed.

14 Select button — Use for selecting channels or layers. Selections are indicated by the channel indicator 
(12). When the MTRX Studio is connected to a monitor profile in DADman these 3 keys are controlling 
DADman and the function is defined in DADman. The default functionality is that the Speaker button 
(15) selects the control room (CR) as focus for the level control encoder, and the A, B, and C buttons (11) 
and the Headphone button (17) selects the monitors/cues as focus. Using the Select button (14), 4 dif-
ferent layers can be selected according to the configuration of the monitor profile in DADman.

15 Speaker button — Selects the control room (CR) as focus for the level control encoder (13) and meter 
(12).

16 Headphone button — selects the monitors/cues as focus for the level control encoder (13) and meter 
(12).

17 Headphone outputs 1 and 2 (stereo 1/4-inch).

For information on assigning functions to the encoder in DADman, see the MTRX Studio Operation 
Guide.pdf.
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Pro Tools | MTRX Studio Back Panel

1 IEC power connector.

2 Reconfig button (see “Reconfig Button” on page 29).

3 Footswitch — the footswitch can used for controlling the DADman monitor profile or talkback (see the 
MTRX Studio Operation Guide.pdf).

4 Word Clock In and Out (BNC).

5 Loop Sync In and Out (BNC).

6 Ethernet 1 and 2 (network or Dante) — Two RJ45 Ethernet ports for Control and Dante (which can be 
set to switched or redundant mode). In redundant mode the control network must be connected to port 1.

7 DigiLink Mini port 1, primary port.

8 DigiLink Mini port 2, primary or expansion port (configured in DADman software).

9 ADAT In and Out 1.

10 ADAT In and Out 2.

11 Main Monitor Out L and R (balanced 1/4-inch).

12 Line Out 1–8 (DB25).

13 Line Out 9–16 (DB25).

14 Mic/Line In 1 and 2 (XLR and balanced 1/4-inch). These inputs are shared with the instrument inputs 
on the front panel, select MIC inputs to use these inputs.

15 Line In 1–8 (DB25).

16 Line In 9–16 (DB25).

Pro Tools | MTRX Studio back panel

In addition to front panel and DADman control, the built in Mic pres can also be controlled from 
Pro Tools (Mac only). For more information, see the MTRX Studio Operation Guide.pdf.
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Digital I/O Connections

Ethernet, RJ45 Connector, Gigabit

Pin 1 BI_DA+

Pin 2 BI_DA–

Pin 3 BI_DB+

Pin 4 BI_DC+

Pin 5 BI_DC–

Pin 6 BI_DB–

Pin 7 BI_DD+

Pin 8 BI_DD–

Analog I/O Connections

Analog I/O 25-pin Female D-sub Connectors

MTRX Studio uses 25-pin D-sub connectors on the back panel for both analog line input (channels 1–8 and 
9–16) and analog line output (channels 1–8 and 9–16).

8-channel Analog In 8-channel Analog Out
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Connections Channels 1–8

Connections for the 25-pin D-sub connector are listed in the table below. The pinning is according to the 
proprietary standard by Tascam.

Pin number Function Pin number Function

1 AIN/OUT 8 + 14 AIN/OUT 8 –

2 GND 15 AIN/OUT 7 +

3 AIN/OUT 7 – 16 GND

4 AIN/OUT 6 + 17 AIN/OUT 6 –

5 GND 18 AIN/OUT 5 +

6 DOUT 2/6 + 19 GND

7 AIN/OUT 4 + 20 AIN/OUT 4 –

8 GND 21 AIN/OUT 3 +

9 AIN/OUT 3 – 22 GND

10 AIN/OUT 2 + 23 AIN/OUT 2 –

11 GND 24 AIN/OUT 1 +

12 AIN/OUT 1 – 25 GND

13 N.C.
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Reconfig Button
The Reconfig button on the back of MTRX Studio should not be used during normal installation. It is in-
tended only as for recovery in case something goes wrong during programming of IP addresses or a soft-
ware upgrade (such as an unintended power loss). It lets you start MTRX Studio in various basic modes so 
it can be restored without having to be returned to the factory.

The Reconfig button is accessed through a hole in the rear panel using a pen or a similar pointed item (such 
as a paper clip). A green LED is visible through the hole. When the Reconfig button is activated, the LED 
lights to indicate the two Recovery modes for MTRX Studio: last used IP Address and DHCP.

Recovery Mode
Use Recovery mode if the software in the MTRX Studio is not operative. In Recovery mode only basic 
boot software is operative in the unit, and new software can be downloaded using DADman software. 

To enter Recovery mode using the last used IP address settings:

1 Power off MTRX Studio.

2 Press the Reconfig button using a pen or a similar (such as a paper clip) and power the unit on. Hold 
while the unit is powering up.

The green LED turns on and MTRX Studio enters Recovery mode. The IP address settings of the unit are 
the last setting used in the unit.

To switch Recovery mode to use DHCP:

 While the unit is in Recovery mode and the green LED is on, briefly press the Reconfig button again.

The green LED turns off, but the MTRX Studio remains in Recovery mode and the IP address settings of 
the unit is set to DHCP. In case there is no DHCP server on the network, the MTRX Studio defaults to IP 
address 10.0.7.20 / 255.255.0.0 after approximately 2 minutes.
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The selection of either recovery mode is fixed after selection. MTRX Studio starts with a basic boot soft-
ware and IP configuration. MTRX Studio will not be operational until a proper firmware has been down-
loaded using the DADman software and the unit has been powered off and back on again. By enabling re-
covery mode with default IP address and network configuration the unit can always be identified on a 
network using the default setup.

Restore Defaults
In Restore Defaults mode, all settings of the unit are initialized and reset to the factory programmed de-
faults. However, the IP address settings of the unit are remain unchanged and do not return to factory de-
fault.

To restore the default settings to MTRX Studio:

1 While the unit is powered on and operating normally, push and hold the Reconfig button for 10 seconds.

2 Release the Reconfig button.

When the Reconfig button is released the firmware of the unit restarts with the factory default settings and 
enters normal operation automatically. 

Note that the IP address referred to is the IP address of the controller/management interface of the unit. 
This is not the IP address of the IP audio interface. This IP address cannot be accessed in recovery or 
restore defaults mode.
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Appendix A: Specifications

Audio Specifications

Microphone and Instrument Input

Analog Line Input

PCM sample rates 44.1, 48, 88.2, 96, 176.4, 192 kHz

Dynamic range (A) > 120 dB

THD+N(A) < –108 dB @ –3dB FS 

Cross talk q < –120 dB

Input Impedance (differential) 2 k Ohm (Mic), 1M Ohm (Inst)

Max input level 21 dBu (Mic), 15 dBu (Inst)

Input gain range/accuracy Adjustable from –18 to 72 dB, in steps of 0.1 dB

Equivalent input noise (A) < –125 dB (Mic), < –121 dB (Inst)

PCM sample rates 44.1, 48, 88.2, 96, 174.4, 192 kHz

Dynamic range (A) > 120 dB

THD+N(A) < –108 dB @ –3dB FS 

Cross talk q < –120 dB

Input Impedance (differential) > 10 k Ohm

Maximum input level Adjustable from 9 dBu to 24 dBu in steps of 0.1 dB
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Analog Line and Monitor Output

Analog Headphone Output

Digital I/O and Synchronization

PCM sample rates 44.1, 48, 88.2, 96, 176.4, 192 kHz

Dynamic range (A) > 118 dB

THD+N(A) –110 dB @ –3 dBFS

Cross talk < 120 dB

Max output level Adjustable from –60 dBu to 24 dBu in steps of 0.1 dB

Output Impedance < 25 R

Max output level Line Adjustable from –66 dBu to 18 dBu in steps of 0.1 dB

Max output level Monitor Adjustable from –60 dBu to 24 dBu in steps of 0.1 dB

PCM sample rates 44.1, 48, 88.2, 96, 176.4, 192 kHz

Dynamic range (A) > 118 dB

THD+N(A), 300 R load < –110 dB @ –3dBFS

THD+N(A), 30 R load < –105 dB @ –3dBFS

Cross talk < 110 dB

Headphone impedance 30 to 600 Ohm

Output Impedance < 1 R

Max output level Adjustable from –80 dBu to 19 dBu in steps of 0.1 dB

Digital I/O formats
Supported sample rate

Pro Tools DigiLink, Dante IP Audio, ADAT/SMUX up to 
192 kHz

Synchronization Internal, Word Clock, Loop Sync, ADAT, and Dante
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Network Interface

Electrical Specifications

Power supply cord must be a light sheathed flexible cord according to IEC60227 (designation 60227 IEC 
52) and include a protective earth conductor having a green-and-yellow insulation. Cross-sectional 
areas min. 3 x 0.75mm. 

Mechanical Specifications

Interface 1000BASE-T, RJ45 connector, 4-pair connection

Power consumption 45 VA max.

Input voltage 90–260 VAC
100–240 VAC Nominal, 47–63 Hz

Mains fuse, mounted in IEC connector 1 A, T1AH/250V

Safety compliance N 60950-1:2006

Mains line plug type Correct type acc. to standard

110–125V UL817 and CSA C22.2 no 42

220–230V CEE 7 page VII, SR section 107-2-D1/IEC 83 page C4

240V BS 1363 of 1984.Specification for 13A fused plugs and 
switched and un-switched socket outlets

Chassis standard 19”, 1 RU

Chassis depth, without connectors mounted 23.5 cm / 9.3”

Chassis body width 43.5 cm / 17.2”

Weight, not including I/O cards 2.8 kg / 6.5 lbs.
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Environmental Specifications

Operating Temperature 0–45º C / 32–113º F

Humidity 20–85% (non-condensing)

EMC compliance EN 55103-1, part 1: emission
EN 55103-2, part 2: Immunity
FCC 47 CFR part 15 (B): emission
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Appendix B: Warranty Claims Information

If you experience a hardware failure within 30 days of purchase, you can return your product to your 
reseller for an exchange.

For warranty claims, contact Avid directly: 

https://www.avid.com/learn-and-support/contact-audio-and-music-support

For non-warranty claims, visit: 

http://avid.force.com/pkb/articles/faq/Avid-Audio-Product-Repairs 
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Technical Support (USA)
Visit the Online Support Center at 
www.avid.com/support
Product Information
For company and product information, 
visit us on the web at www.avid.com
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